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Motivation

New challenges in the development of electric drive systems
 Application specific requirements getting more restricted

Faster response times to customer inquires and shorter development times

Different motor designs available and more competitors on the market

System performance map required during tendering stage

Simulation { Virtual Prototype }
Concept
) - Simulation-Driven
esign
- Product Development Prototype

Parametric Design <:| Desian Analvsis
Optimization g y
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|— Analytical Approach

= FEM Simulation

More Details

Multiphysics

m Coupled Analysis

System

= Behaviour Models
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Simulation Depth

|— Analytical Approach

= FEM Simulation

reliminary Design Phase

-

ma Coupled Analysis
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Simulation Requirements
Preliminary Design Component Development System Engineering

Electro-
magnetic

k CAD Data, Material Libraries, Optimization, Sensitivity, Robustness }
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Preliminary Design

Preliminary Design .
y J Obijectives

* Investigation of the possibilities
» Fast evaluation of different designs

Electro- » Coupled preliminary electromagnetic and thermal analysis

magnetic

» Fast evaluation of performance maps and duty circles
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Preliminary Design
Preliminary Design N 2
y J Objectives
* Investigation of the possibilities
Workflow Handling,
W) SR, e » Fast evaluation of different designs

» Coupled preliminary electromagnetic and thermal analysis
» Fast evaluation of performance maps and duty circles

Requirements

» Software to evaluate fast and accurate electromagnetic
A and thermal behaviour

» Capability for preliminary optimization and sensitivity
analysis
« Automated workflows for data exchange

CAD Data

Material Data
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Motor-CAD Software
Motor

» Motor-CAD EMag, Therm and Lab modules are developed to Desian
enable fast and accurate analysis in one integrated software Lmu?ed

EMag

» EMag: Afast 2D finite element module for accurate
electromagnetic and electrical performance predictions.

» Therm: Combines a lumped circuit and finite element

thermal calculation for optimising the cooling system of L
a machine.
> Lab: Provides efficiency mapping and duty cycle / drive Motor-CAD

cycle transient outputs within minutes

Written by motor design experts in the language
of the motor designers so very easy to use.
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How to use Motor-CAD

» Extensive range of parameterised templates
« Design Variables, Winding Type, Cooling Type, ...

« Simple input masks in the form of tables
» Geometry, Winding, Materials, ...

« Automatic setup for different simulation tasks
» Steady-State & Transient Thermal Analysis
+ Performance Tests: Single Operating Point, Open
Circuit, On Load, Transient, ...

» Fast and accurate solver technique
» Fastest FEA electromagnetic solver (assembly code)
* FEA thermal solver for windings

* Coupled Analyses
» Easy switching between electromagnetic and thermal
setup

« Enhanced capabilities
« Scripting, Smart loss calculation algorithms,
Manufacturing data built into models

* All in one GUI
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Data Evaluation
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Automation of Workflow and Optimisation

« Graphical programming, based on templates, ? Sutimizaiion A
wizard-based derivatives » L,_’: ( g?, B Em g X

 Post-Processing: visualization, main info at a ey : BB
glance, investigation when needed B { T — cpSeacing g il d

 State-of-the-art sensitivity analysis + MOP + Robust d hmd B Mgy - g
Design Optimization - —— e "°" e

SendMail

© Dynardo GmbH

pre-calculation

v
optimize:
slots, poles, winding

¥ * Investigative research -> gain insight & understanding

optimize:

peaktorquiHherma' » Establish workflows - benefit from your (codified) competence

optimize:

multiple load cases / map * Integrated Workflows - optiSLang connects
v

optimize:
NVH, 3D, losses

© Dynardo GmbH
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Component Development
Component Development Objectives Y
» Detail analyses of the electric drive ‘/

* Investigation of transient or three dimensional
effects on the electromagnetic behaviour

» Coupled and uncoupled structural, thermal and
power electronics simulations

» Generating deeper physical understanding and
there dependence on the electric drive system

» Acoustics simulations (NVH)
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Component Development

Component Development

)

Workflow Handling, Optimization, Sensitivity,
Robustness and MOP

MAXWELL
Electromagnetic)

CFD

\(Thermal)

/ﬂ ) .ANSYS o

EE T

TWIN BUILDER
(Power Electronics)

i
k'_, @ WORKBENCH

(Multi Physics)

MECHANICAL
(Structural) f

CADFEM CADFEM
Extension Extension
L CAD

Materi%r/Data

ool
\_ J
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Objectives

K’

XY
Q

\

Detail analyses of the electric drive

Investigation of transient or three dimensional
effects on the electromagnetic behaviour

Coupled and uncoupled structural, thermal and
power electronics simulations

Generating deeper physical understanding and
there dependence on the electric drive system

Acoustics simulations (NVH)

Requirements

High-end simulation tools for the different physical
domains

Easy coupling between the results from different
domains (Simulation Platform)

Sensitivity and robustness analysis over different
tools and many parameters

Workflow automation and file data handling

SIMVEC, 20. — 21. November 2018, Baden-Baden 14



CADFEM

Simulation Platform

MAXWELL

* Electromagnetic Fields
* Induced Voltage

* Induction Matrix

* Forces & Torques

* Losses

Bi-Directional
CAD integration

Losses:
- Eddy Current
- Core

m Winding

Input Results
to Harmonic
Solver

Temperature
and Force

.
®
o
®

/ - 863 pwanetes

WORKBENCH
» Simple Exchange of Data
» Connecting by Drag and Drop
* All Physics Domain in one GUI
* Coupled Optimisation

™
-

CFD
» Heat transfer Coefficient
» Temperature Distribution
* Flow Characteristics

Twin Builder
» Control Parameters
» System Behaviour
* Power Electronics

i

MECHANICAL
* Stress, Stiffness and Deformation
 Eigenmode
» Temperature Distribution
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Electronic-Electromagnetic Coupling

LabellD=IVoltmeter64.

* Influences of power electronics
« Sinus vs. PWM excitation
+ Additional Losses

« Control loops
* Optimization
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Electromagnetic-Thermal Coupling
Why coupling?
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The losses obtained by EM-Simulation are used as @i
realistic loads. oy

3 G, Heat Flux

n
(| Heat Generation

: Imported Loa
B~ 48 Solution (C6)

» Thermal analysis without fluid dynamics S P ' -
« Conduction, diffusion, advection, convection and radiation T 4
» Special elements for advection M‘} ‘,f
» Solves faster due to smaller project size P 4
» Convection has to be defined by boundary condition
* Thermal Heat Coefficients has to be taken from literature ; ; T E

2 |&@ Geometry  ,——=2 @ Geometry / ,——m2 i@ Geometry
3 & setup v 4 Geometry 3 @ Mesh
/ A

-
« Thermal analysis with fluid dynamics s\ [Tlar——
+ Solves for heat transfer coefficient e~

» Higher accuracy for fluid problems 4 -

« Setting up of the model is more complex
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Electromagnetic-Structual Coupling

Automated load transfer from magnetic field analysis
» Uncoupled or Coupled Simulations
« Static Simulation
» Stresses (E-Steel, Housing)
« Deformation
» Resonance Frequencies
« Dynamic Simulation
» Harmonic response based on magnetic forces

- A - B - c
(] Transfer Of translent magnetlc Ioads to 2 & Geometry ~ ————=e2 @) Geometry + , 2 C Engineering Data v ,——=& 2 Q Engineering Data v
3 Setup v Geometry 3 |l Geometry « ,——m3 () Geometry v .
H 4 @ souton 4@ Model v ,——m3 @ Model v .,
frequency domain by DFT oy T -
6 solution 6 |§3 Solution v .,
v -

v 4
7 |@ Results v 7 @ Resuls

Modal Harmonic Response
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CADFEM ANSYS Extension - Electric Drive Acoustics inside ANSYS

Workilow: ( ANSYS Mechanical with Electric Drive Acoustics

Inside ANSYS E.D.A. inside ANSYS €3 | & 5 | & | B &

External computation
of excitation loads

Electro- Harmonic Oscillation,

magnetic DFT ~ Vibration / ERP,

Analysis L« Analysis Waterfall Plot
Excitation L A

Loads
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System Engineering

System Engineering

Obijectives OO
« Analysis and optimization of a system without
extensive coupled FEM simulation "

» Generating accurate behavior models from the
component analysis

m * Implementation of third party behavior models
]  Fast evaluation of performance maps and duty

AL ;@ circles on a system level
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System Engineering

System Engineering  Objectives O
* Analysis and optimization of a system without O

Optimization extensive coupled FEM simulation ‘z
y}) m and Sensitivity . ]
» Generating accurate behavior models from the
" ANSYS ) component analysis
o Ece o] L1 [ « Implementation of third party behavior models
TV% BU,L[fR  Fast evaluation of performance maps and duty
— B circles on a system level
MOR_o o SPL l o
A/
z AN .
/ Requirements
CADFEM * Physical based system simulator with the possibility
=xtension Tz oo to generate State Space Model, Reduced Order
SPICE Models, MOP, ...
& & VHBL-AMS - T  Implementation of 3" party models

« Optimization, sensitivity and robustness analyses
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Language-Based
Modeling

Multi-Domain
Model Libraries

L
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Industry Standards Thousands of Built-in

for System Modeling
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Component Models

Co-simulation
with 3D Physics

Reduced Order
Model Creation

Embedded Software
Integration

System Model
Interoperability

u
FUNCTIONAL
MOCK-UP

- J

e emmmy |INTERFACE

Interfaces with all ANSYS 3D Physics
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ANSYS SCADE
and More

34 Party System
Modeling Tools
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CADFEM ANSYS Extension — Model Reduction inside ANSYS

Model Reduction in ANSYS Mechanical with CADFEM MOR-ACT

Mechanical Generate ROM Twin Builder

Transient Thermal moracT [ [] LY = B Transient System

|| fmain full P —— T & il = - CASCON_MORACT_ECE_Cycle

Heat_Generation_1.full Input Options I m
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., .
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3 || generated_post VHDL-AMS.log | | |mor. th\) Em 5 e [ 290 uu%
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Preliminary Design

)

Workflow Handling,
Optimization,
Sensitivity and MOP

Component Development

j _ Workflow Handling, Optimization, Sensitivity,
b’) optiSLang’ Robustness and MOP

-

EMag

Motor- CA

~N /ﬁ @ ANSYS @

CFD
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L

== g=m gme= w=em|  TWIN BUILDER

MAXWELL , !
(Electromagnetic) | - P2 7 | (Power Electronics) - E&] 8021_ ©

R' @ > TWIN BUILDER
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Extension
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Material Data
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CADFEM
Extension

IModel Reduction inside ANSYS|
Wachi

NANSYS

System Engineering
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wu
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* An integrated workflow for the simulation-driven development of electric
motors was presented.

* The importance of an compact and fast simulation tool chain for the
preliminary design phase was highlighted.

» Easy coupling of different physical domains is important to get realistic loads
and accurate results.

» The development process have to be accompanied by optimization and
sensitivity studies.

 Parts of the workflow was already implementation in the development
process from our customers
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Simulation ist mehr als Software®

Simulation macht vieles maoglich

Gemeinsam holen wir das Beste heraus
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